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Introduction

The Webex WFO Cloud Platform Design Guide provides a high-level overview of the structure and
components of Webex WFO. The guide details the following:

m Edge components
= System requirements
m Platform ACD configurations
m Platform capture configurations
m Data transfer flowcharts
The Cloud Design Guide provides generalized knowledge on the aforementioned details. For more

specific details on supported integrations see the Calabrio ONE Integration Guides. All user

documentation can be found on the User Documentation page on the Calabrio Success Center.

The guide is designed for Cisco implementation and support engineers, Cisco sales engineering
employees, partners, and customers; however, Cisco development, marketing, sales, and other employees

across the organization could also find it useful.



https://success.calabrio.com/s/article/User-Documentation-User-Guides




Edge Components

The Webex WFO Edge components are generally deployed at an on-premises or remote customer site. The
components as a whole comprise the Webex WFO Smart Technology Suite. The images below describes

the edge components of Webex WFO and the Data Server:
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Edge Components | Webex WFO Smart Data Server

Calabrio ONE Smart Data Server

Signaling Service

ACD Sync Service

. Sync Active Directory HRMS Export
« CTI + Capture Sync Service Service
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Reconciliation Device Sync SETP for CDR Staged Upload
Service Service Service SELE
i Local Web Media Import Audio Capture
GIS Service Service Service Service
QM ACD WFEM ACD

Capture Service

Capture Service

Webex WFO Smart Data Server

The Webex WFO Smart Data Server is responsible for functions such as ACD synchronization and staged
uploads. A tenant administrator can install the Data Server for a singe tenant, or a system administrator

can install a base Data Server and configure it as a shared Data Server for multiple tenants.

NOTE If the Data Server must connect through a web proxy, all Webex WFO services running
on it must run as Windows login accounts with proxy settings. When configuring the Data Server

with a proxy server, the Data Server service must be configured to run as a local administrator.
The services installed with the Data Server software are as follows.

m Webex WFO CTI Signaling Service

m Webex WFO Data Server
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Edge Components | Webex WFO Smart Data Server

m Webex WFO Data Server Web Services
m Webex WFO Network Recording Service

m Webex WFO SIPREC Service

In Webex WFO, the following are functions of the Data Server, their descriptions, and the service they

align to.

m Webex WFO Regional Data Server ACD Sync Settings — Used to sync user and team information
from a supported ACD (Webex WFO Data Server).

m Webex WFO Recording Capture Server Settings — Used for edge server or gateway (SBC) audio
recording environments. The primary Signaling service (CTI or SIPREC) assigns calls to capture

servers in a round-robin algorithm (Webex WFO Network Recording Service).

m Webex WFO Regional Data Server GIS File Location — Used to import external contact metadata
from a CSV file into Webex WFO (Webex WFO Data Server).

m Recording SIPREC Signaling Server Settings — Used to track start and stop events and capture
metadata for call recordings. A SIPREC Signaling service is used for edge gateway (session border

controller) recording environments (Webex WFO SIPREC Service).

m Recording CTI Signaling Server Settings — Used to track start and stop events and capture
metadata for call recordings. A CTI Signaling service is used for edge server recording

environments (Webex WFO CTI Signaling Service).

m Webex WFO Regional Data Server Staged Upload Settings — Used to gather contact data locally
from Smart Desktop users and periodically upload the files to the Webex WFO components in the
Cloud (Webex WFO Data Server).

m Regional Data Server ACD Capture Settings — Used to capture custom metadata and reconcile

calls received through a gateway (Webex WFO Data Server).

m Regional Data Server Real-Time Event Settings— Used to capture historical and real-time ACD
data for WFM and ACD metadata to attach to call contacts as custom metadata (Webex WFO Data

Server).

m Regional Data Server Reconciliation Settings — Reconciliation is a process that connects gateway
root recordings, which have limited call data, with additional call data that includes association

with the correct agent (Webex WFO Data Server).

m Webex WFO Active Directory Sync — Enables Webex WFO to match and sync Webex WFO
users with Active Directory users (Webex WFO Data Server).
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Edge Components | Webex WFO Smart Data Server

m Webex WFO Data Server Device Sync Settings — Enables you to sync devices through the Data
Server. These devices can then be associated to users, recording groups, and recording types using

the Device Associations page in Application Management (Webex WFO Data Server).

m Webex WFO Local Web Service Settings — Enables API integration on this data server. If

enabled, you have the option to enable the following:

m Cisco IP Phone Services Controls — Allows Calabrio-enabled recording controls from

supported Cisco devices.

m Simplified Recording Controls APl — Enables you to use the native data server

authentication for Calabrio recording controls.
m Webex WFO HRMS Configuration — Enables the Data Server to export data to a human resource
management system (HRMS) (Webex WFO Data Server).

m Webex WFO SFTP Configuration — Enables you to configure your SFTP server (Webex WFO

Data Server).

m Webex WFO Media Import Server Settings — Enables the import of recording files from an
external location (Webex WFO Data Server).

Webex WFO ACD Sync Service

The ACD Sync service is used to sync user and team information from a supported ACD. The Sync

process runs every ten minutes to update any changes made in the ACD into Webex WFO.

Data Server: Customer ACD
ACD Sync Service
Service

ACD Sync Service Connectivity

The following table lists the basic connectivity to the ACD Sync service:

Connect to Service Inputs/Outputs

Tenant’s ACD Service Updates to ACD agent or team information

12



Edge Components | Webex WFO Smart Data Server

Webex WFO Audio Capture Service

Webex WFO uses the Audio Capture service for edge server or gateway (SBC) audio recording
environments. It can be assigned to clusters. The primary Signaling service (CTI or SIPREC) assigns calls
to capture servers in a round-robin algorithm. Audio Capture services can be configured as active/active or

active/standby.

Data Server Services
i A
CTI |SIPREC|
Service Service
N
I 18 18§
& 15 15, Audic |[QM ACD
I8 18 18 o || o
15 16 18

Audio Capture Service Connectivity
The following table lists the basic connectivity to the Audio Capture service:

Connect to Service Inputs/Outputs

CTI service Receives signaling for audio capture

SIPREC service Receives signaling for audio capture
Webex WFO GIS Service

Use the Generic Interface Service (GIS) service to import external contact metadata from a .CSV file into

Webex WFO.
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l Customer ACD
Service

Data Server:
GIS Service

GIS Service Connectivity

The following table lists the basic connectivity to the GIS service:

Connect to Service Inputs/Outputs
Tenant’s ACD Service Updates to ACD agent or team information
External .CSV file External flat-file source for agent or team information updates

Can be single or multiple files

Webex WFO Signaling Service
Your Signaling service can be either CTI or SIPREC:

m A CTI Signaling service is used for edge server recording environments, to track start and stop

events and capture CTI metadata for call recordings.

m A SIPREC Signaling service is used for edge gateway (SBC) recording environments to track start

and stop events and capture SIPREC metadata for call recordings.

You can configure either the CTI or SIPREC services for redundancy.

NOTE The Audio Capture service can only be linked to one telephony group that includes a CTI
or SIPREC service.
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PBX Gateway —

Data Server:
Signaling Service

Data Server:
SIPREC Service

Data Server: CTI
Service

| \

V
i

Data Server: Audio
Capture Service

Signaling Service Connectivity
The following table lists the basic connectivity to the Signaling service:

Type Connect to Service
CTI PBX service
Audio Capture service
SIPREC Gateway/SBC Service
Audio Capture service

QM ACD Capture service

Webex WFO Staged Upload Service
The Webex WFO Staged Upload service gathers contact data locally from Smart Desktop Client users and

periodically uploads the files to the Webex WFO components in the cloud.
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Edge Components | Webex WFO Smart Data Server

Two-Stage
Upload Component
Ir m Data Server.
Staged Upload
Smart Desktop Service
L L[ —

Two-Stage Upload Component
The Two-stage Upload component enables you to periodically send data from the Data Server to the

Webex WFO core components.

Staged Upload Service Connectivity
The following table lists the basic connectivity to the Staged Upload service:

Connect to Service Inputs/Outputs

Tenant’s ACD Service Updates to ACD agent or team information

Webex WFO QM ACD Capture Service

Webex WFO uses the QM ACD Capture service to capture custom metadata and reconcile calls received

through a gateway.
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D

Data Server. QM ACD Capture Service

ACD Sync Reconciliation Device Sync SFTP for CDR
— PBX
Service

QM ACD Capture Service Components

The QM ACD Capture service is composed of four components:

= QM ACD Historical Capture Component
m QM ACD Real-Time Capture Component

m QM GIS Capture Component

QM ACD Historical Capture Component
The QM ACD Historical Capture component captures custom metadata and reconciliation data from the

ACD.

QM ACD Real-Time Capture Component
The QM ACD Real-Time Capture component captures contact data.

QM GIS Capture Component
The QM GIS Capture component imports external QM contact metadata.

QM ACD Capture Service Connectivity
The following table lists the basic connectivity to the QM ACD Capture service:

Connect to Service Inputs/Outputs

Tenant’s ACD Service Updates to ACD agent or team information
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Edge Components | Webex WFO Smart Data Server

Webex WFO WFM ACD Capture Service
The Webex WFO WFM ACD Capture service captures historical and real-time ACD data for WFM and

ACD metadata to attach to call contacts as custom metadata.

3

Data Server: WFM ACD Capture Service

WFM ACD Real- WFM ACD WFM WHIT
time Capture Historical Capture WFg‘ SIS CEE T Capture
omponent
Component Component Component
S~ N -
CSV
ACD
Service —

WFM ACD Capture Service Components

The WFM ACD Capture service is composed of four components:
m WFM ACD Historical Capture Component
m WFM ACD Real-Time Capture Component
m WFM GIS Capture Component
m WFM WHIT Capture Component

WFM ACD Historical Capture Component
The WFM ACD Historical Capture component captures historical and real-time ACD data for WFM as

well as ACD metadata to attach to call contacts as custom metadata.

WFM ACD Real-Time Capture Component
The WFM ACD Real-Time Capture component captures contact data.

WFM GIS Capture Component
The WFM GIS Capture component captures ACD data from non-direct ACDs.

WFM WHIT Capture Component
The WFM WHIT Capture component allows you to import historical ACD data.
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WFM ACD Capture Service Connectivity
The following table lists the basic connectivity to the WFM ACD Capture service:

Connect to Service Inputs/Outputs

Tenant’s ACD Service Updates to ACD agent or team information

Webex WFO Local Web Services Service

The Webex WFO Local Web Services Data Server service enables recording controls and native Data

Server authentication.

I NOTE The Local Web Services service is not supported with CCaaS vendor deployments.

o

Cisco |P Phone Data Server:

Services Controls \ Local Web Services

Local Web
Services

Simplified
Recording
Controls APIs

Local Web Services Service Components
The Local Web Services service is composed of two components:

m Cisco IP Phone Services Controls component

m Simplified Recording Controls API component

Cisco IP Phone Services Controls Component
The Cisco IP Phone Services Controls component enables Cisco recording controls from supported Cisco

devices.

Simplified Recording Controls API Component
The Simplified Recording Controls API component allows for use of native Data Server authentication for

Cisco recording controls.

19



Edge Components | Webex WFO Smart Desktop Client

Local Web Services Service Connectivity
The following table lists the basic connectivity to the Local Web Services service:

Connect to Service Inputs/Outputs

Simplified Recording Data Server authentication for Cisco recording controls

Controls API

Cisco IP Phone Services Allows native Data Server authentication for Cisco recording controls

Controls

Webex WFO Smart Desktop Client

The Smart Desktop Client is installed on agent desktops or on a server that hosts a supported thin client.

(See Thin Client Servers for more information.) It captures all user data (including call recording, screen,

and desktop activity) on an agent’s desktop. You must add the installer on the Downloads page in

Application Management, so that it can be accessed by the tenant administrator.

Staged Upload CTI1 Signaling
Server Server

IE \ Smart Desktop Client

N Audio Recording
Desktop Analytics Live Monitoring Client AP
Component Component Component
| I —+— Screen Recording
[
Soh
(]

Users with Smart Desktop Client installed who are configured with the required permissions can perform

Live Audio and Live Screen monitoring.
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Smart Desktop Client Components
The Smart Desktop Client contains four components:

m  Audio and Screen Recording component
m  Desktop Analytics component
m Live Audio Monitoring and Live Screen Monitoring component

m Client API component

Audio and Screen Recording Component
The Audio and Screen Recording component records agents’ calls.

Desktop Analytics Component

The Desktop Analytics component provides analytical analysis of the agent’s desktop recordings.

Live Audio Monitoring and Live Screen Monitoring Component
The Live Audio and Live Screen Monitoring component allows users with the appropriate permissions set

to perform Live Audio and Live Screen monitoring.

I NOTE Live Audio Monitoring is not supported with CCaaS vendor deployments.

Smart Desktop Client Connectivity
The following table lists the basic connectivity to the Smart Desktop Client:

Component Connects To Inputs/Outputs

Audio and Screen Recording Agent’s PC Phone audio and screen data
Desktop Analytics Agent’s PC Phone audio and screen data
Live Monitoring Other agents’ PCs Other agents’ phone audio and

screen data

Connect to Server Inputs/Outputs

Staged Upload Contact information (audio and screen recordings and metadata)

21






System Requirements

Webex WFO Release Notes contain the latest information regarding changes to system requirements,

compatibilities, bug-fixes, and new features. Archives of past Release Notes are available.

Supported Environments

Webex WFO supports a number environments and technologies.

For the latest supported compatibility information, visit www.cisco.com.

Desktop Hardware

The hardware requirements for Webex WFO desktops are as follows:
Desktop Hardware
NIC 100 Mbit NIC

NICs must support Promiscuous Mode.

Configure Windows power settings to disable “Allow the computer to

turn off this device to save power” on the network interface cards.

Disk space 20 GB

voice recording storage (MB) = number of recordings X average call

length x 0.5 MB per minute

NOTE
This formula is based on a 64 kbps (kilobits per second) audio

bitrate.

[(64 kbps x 60 sec) = 8 bits] + 1024 KB = 0.46875 MB per

minute

screen recording storage (MB) = number of recordings x average call

length x 1.5 MB per minute
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System Requirements | Desktop Software

Desktop Hardware

NOTE The storage requirements for screen recordings depend
on three factors: recording length, monitor resolution, and the
number of monitors being recorded. The value shown here is
based on a single monitor. Each additional monitor is recorded

separately, so you must apply this formula for each monitor.
CPU Intel Core 2 Duo 2.0 GHz, Core i3, AMD Athlon 64 X2 or better

Memory 2 GB

Desktop Software

.NET Framework
Webex WFO Smart Desktop requires .NET Framework 4.5 for the Analytics feature. If it is not installed,

Webex WFO will not be able to capture browser events as part of the Desktop Analytics data. You can
download the .NET Framework from http://www.microsoft.com/en-us/download/details.aspx?id=30653.

WebM Media Foundation Components
Webex WFO requires the WebM Media Foundation Components installed on the desktop. This codec

allows you to play back audio and screen recordings in WebM format.

You can download WebM Video from https://tools.google.com/dlpage/webmmf/.

Browsers
Any browser you use must allow file downloads. Popup blockers must be disabled.

NOTE It is recommended that you disable the Internet Explorer browser’s smooth scrolling
option to prevent “screen bounce” when working with Webex WFO. To do this, open Internet

Options. On the Advanced tab, locate Browsing > Use smooth scrolling and clear the check box.

Internet Explorer and Windows
By default, Windows 8.1 opens Internet Explorer 11 in the Metro mode. This mode is not supported with

Smart Desktop’s capture feature. Desktop capture requires that Internet Explorer be run in Desktop mode.

To run Internet Explorer in Desktop mode, pin it to the Windows taskbar and launch it from there.
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System Requirements | Desktop Software

Desktop Analytics Plugin/Extension
Users who administer fields for Desktop Analytics via the Field Manager page in Webex WFO and agent

desktops that have Smart Desktop installed must have the Cisco Analytics browser extension/plugin
enabled. The plugin is required not only for marking fields in the browser but also for monitoring agent

web activity within the browser.

Enable the Desktop Analytics extension in Internet Explorer
The Desktop Analytics plugin is automatically installed and enabled when Smart Desktop is installed. No

further action is required.

I NOTE When agents are using Internet Explorer, the Desktop Analytics Plugin/Extension will not

capture field-level events on pages that render in document modes before Internet Explorer 8.

Enable the Desktop Analytics extension in Firefox
The first time you log in to Webex WFO using Firefox, you see a dialog box telling you to install the

Calabrio Browser Extension. Select Allow this installation and click Continue. No further action is

required.

Enable the Desktop Analytics plugin in Chrome
Download and install the Calabrio Analytics Plugin, version 0.1.5. The plug-in is located at:

https://chrome.google.com/webstore/detail/calabrio-analytics-plugin/hecgknieibccghjmmhhckdfeobjoffdf

I NOTE If clicking the link does not work, copy the URL and past it into your browser.

Adobe Acrobat Reader

The Adobe Reader is required to open exported PDF files and user documentation. A free Acrobat Reader

download is available at www.adobe.com.

IMPORTANT There are known issues with Adobe Reader versions that use the Security
(Enhanced) feature. If you plan to use the Desktop Analytics feature, you must navigate to
Security (Enhanced) under Preferences in Adobe Reader, clear the Enable Protected Mode at
startup and Enhanced Security check boxes, click Yes for any warning messages, and then click
OK to save your changes. When finished, restart Adobe Reader for the changes to take effect. If
Adobe Reader is not configured correctly, Desktop Analytics will not be able capture events
related to Adobe Reader.
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System Requirements | PCI DSS Compliance

Desktop Software and Audio Capture

In order for Smart Desktop to perform proper phone detection and audio capture, the ability to detect and
capture certain network protocols (such as SIP, SCCP and RTP) is required. Any software running on the
PC that interferes with, redirects, or otherwise hides network traffic will cause Smart Desktop to fail to

function correctly.

EXAMPLE The SonicWall VPN client with the Deterministic Network Enhancer (DNE)
lightweight filter enabled causes outgoing network traffic to be redirected from the network
adapter that Smart Desktop uses. In this case the DNE lightweight filter must be disabled to allow
Smart Desktop to function correctly.

PCI DSS Compliance

I NOTE Webex WFO v10.3 and higher supports TLS v1.2 and has deprecated TLS v1.1.

About Storage

It’s important to note the difference in required storage type in Webex WFO.

Media storage is the permanent storage for media files. It is suitable for long-term storage, and it is not
used for playback unless high speed network storage is also configured to use the same location. See

Media File — Standard Storage and Media File — Archival Storage to learn more.

High Speed Network Storage refers to the high speed network used for storage of temporary files,
folder location where all operational processing takes place, and where analytics (Lucene) data is stored.
This includes bulk export processing, the Lucene index location, media conversion, media playback, and

files that are deleted after 24 hours by the system throughout the day with the exception of analytics.

NOTE Analytics files are stored in high speed network storage but are not included in the
deletion of files by the system throughout the day.

When a call is requested for playback, the system pulls the file from permanent storage and places it in
the temporary directory within the High Speed Network Storage level for instant access (see High Speed
Network Storage). From there, it performs transcoding and streaming.

Storage Types

One consideration your organization should make prior to installing Webex WFO is whether to use

network-attached storage (NAS), storage area network (SAN), or a file server as your storage type.
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System Requirements | About Storage

BEST PRACTICE Before any tenants are created, ensure you have a SAN or a file server that is
to be used for high speed network storage. NAS devices should not be used. NAS devices are not
intended for fast delivery of data and likely have more traffic on the device. Customers should use
a SAN, but a file server in close proximity to platform servers, as in the same data center, is also

acceptable as the high speed network storage location.
High speed network storage ideally should be a SAN or other device intended for fast access.

NAS and SAN were developed to solve the problem of making stored data available to many users at
once. Each provides dedicated storage for a group of users, but they use different approaches to achieving

their mission.

NAS is a single storage device that serves files over an Ethernet connection and is relatively inexpensive

and easy to set up.

SAN is a tightly coupled network of multiple devices that work with block-based data and is more
expensive and complex to set up and manage. From a user perspective, the biggest difference between
NAS and SAN is that NAS devices look like volumes on a file server and use protocols like NFS and
SMB/CIFS, while SAN-connected disks appear to the user as local drives.

Admin Configuration
When configuring the system for the first time, the Default Media Storage Location is configured on

the System Administrator Storage Location page.

NOTE During initial setup the Default Media Storage Location is your high speed network
storage and media storage location. Further action is needed to separate high speed network
storage and media storage to different locations. Network and media storage locations have
drastically different performance characteristics. This is why selecting both options as the default

storage location is not recommended because it can lead to performance issues.

Configure Separate Network and Media Storage Locations

1. Before creating any tenant, navigate to the System Administrator portal > Application

Management > System Configuration > Storage Location.
2. Click Create a new storage location.
3. To create a high speed network storage location, enter a unique name in the Name field.
4. In the Type drop-down list, select Network (Instant Access).
5. Under Defaults, select the Network check box.

6. Configure the remaining Network Storage Configuration fields.
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10.

11.

12.

13.

14.

Click Save.

To create a media storage location navigate back to Application Management > Storage Location.
Click Create a new storage location.

To create a media storage location, enter a unique name in the Name field.

In the Type drop-down list, Network (Instant Access) is pre-selected.

Under Defaults, select the Media check box.

Configure the remaining Network Storage Configuration fields.

Click Save.

I BEST PRACTICE Delete the initial Default Media Storage Location after the new locations

for Network and Media storage are configured.

Configure Tenant Storage
Conduct this procedure when creating a new tenant from the System Administrator portal.

1.

2.

Navigate to Application Management > Tenant Administration > Tenants.

Within the Storage Location section, find the default high speed network storage location and

select the Available check box.

Find the default media storage location and select the Available check box and Default check

box.
Click Save.

To validate, log in to the tenant and navigate to Application Management > System Configuration

> Storage Profiles.

Click the Storage Location drop-down list. The network and media storage locations appear in

the drop-down list.

I NOTE Do not choose Network storage for a storage profile.

Storage Levels
There are three levels of storage for contact data:

m Amazon S3 (Immediate Access) — Amazon S3 storage (standard) is used for shorter-term storage

(12—-24 months) of day-to-day operational content, such as media files (voice and screen) and
historical data for reporting, forecasting, and scheduling. The response rates to user requests can be

near immediate in seconds, yet can vary slightly depending on the amount of data or the type of
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data being requested. This is the recommended default storage location.

m Amazon S3 Shared (Immediate Access) — Similar to the Amazon S3 storage level except multiple

tenants store their data within the same Amazon S3 storage bucket in a tenant specific folder.

m Network (Instant Access) — Network storage (performance) is used for user-driven media content,
Analytics, and Datamart content. This is a storage area network (SAN) or a file server. It provides a
near-immediate response rate to user requests. This data is resident for a workflow-defined period
of time, after which it is purged. Optionally, administrators can specify a staged upload location,

which holds data before uploading it to the long-term real-time data storage location.

You can also choose to have a third party store your data after it has reached the end of its retention
period. After the data is stored, it is purged from Webex WFO. When you retrieve stored data, you must

use applications other than Webex WFO to review it.

Related Topics

See the Webex WFO System Administrator User Guide for more on the following topics.

m Tenants - Use the tenant Storage Location section on the Tenants page to assign and define the

storage location for each tenant.

m Tenants - Use the tenant Data Retention section on the Tenants page to define the data retention
for each tenant. You can also copy the data retention settings from one tenant to one or more other
tenants. Tenants can modify these values by selecting shorter retention periods than those specified

here.

High Speed Network Storage and Media Storage

Comparison
The following table describes the main differences between High Speed Network Storage and Media

Storage. NAS has many similarities to Webex WFO Media Storage. SAN has many similarities to Webex
WFO High Speed Network Storage.

NAS SAN

Typically used in homes and small to medium Typically used in professional and enterprise
sized businesses. environments.

Less expensive More expensive
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NAS SAN

Easier to manage Requires more administration

Data accessed as if it were a network-attached Servers access data as if it were a local hard drive
drive (files) (blocks)

Speed dependent on local TCP/IP usually Ethernet High speed using Fibre Channel, 2 gigabits to 128
network, typically 100 megabits to one gigabit per gigabits per second. Some SANs use iSCSI as a

second. Generally slower throughput and higher less expensive but slower alternative to Fibre
latency due to slower file system layer. Channel.

I/O protocols: NFS, SMB/CIFS, HTTP SCSI, iSCSI, FCoE

Lower-end not highly scalable; high-end NAS Network architecture enables admins to scale both

scale to petabytes using clusters or scale-out nodes performance and capacity as needed

Does not work with virtualization Works with virtualization

Requires no architectural changes Requires architectural changes

Entry level systems often have a single point of Fault tolerant network with redundant
failure, e.g. power supply functionality

Susceptible to network bottlenecks Not affected by network traffic bottlenecks.

Simultaneous access to cache, benefiting

applications such as video editing.

File backups and snapshots economical and Block backups and mirrors require more storage.

schedulable.

The main differentiators between NAS and SAN are that NAS is slower, has a lower throughput, and
higher latency. NAS is generally less expensive and simpler. NAS is also used for simple file storage and
media retrieval, and it is connected via HTTP, LAN/WAN, etc.

Compared to NAS, SAN is faster and based on a network of pooled storage devices. SAN is generally
more expensive, and is used for high transaction areas such as databases and web servers/processing.
Unlike NAS, SAN is connected via iSCSI.
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Webex WFO Storage Types

High Speed Network Storage
High Speed Network Storage characteristics are very similar to a Storage Area Network (SAN).

= High IOPS
m Low Latency
m High Performance Drives

m High Transactions and Response Rates required

In Webex WFO High Speed Network Storage is used for the Microsoft SQL database and Analytics

Lucene database.

STORAGE DEVICES

Media Storage
Media file standard storage characteristics are very similar to network attached storage (NAS).

m Simple to Setup
m Less Expensive
m Looks like a standard local drive to the user

m Similar to a File Server for files and media

In Webex WFO Media Storage is used for audio and screen files.
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NETWORK ATTACHED STORAGE (NAS)

STORAGE DEVICE

Storage Diagrams

Use Cases for Diagram Process Flows

1.

Process flow to record and upload a recording from a client.

The client can be a server or an agent PC.

2. Process flow to playback files.
3. Process flow to export files.
4. Process flow to analyze files.
5. Temporary file characteristics (Self-Cleaning).
Files are stored for 24 hours on high speed network storage and then they are deleted.
Webex WFO Storage Types

The following diagram depicts recommended storage by data type.

I IMPORTANT High Speed Network Storage and Media File Storage locations require different

types of storage performance and should never be configured on the same storage drive.
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Examples of Archival Storage: I

AWS Glacier (Cloud), Offline or Tape Storage Media File: Archival Storage

Archive or Offline Storage
I Standard or Archive Performance Drive & I0PS
(Mot Required)

Lower Throughput and Higher Latency
I Standard Performance Drive & I0PS

ll % I ﬁ Media File: Standard Storage

MAS, File Storage,

File Server
- e mm Em EE EE EE EE EE Em

© .
| W High Speed Network Storage
High Throughput - Low Latency
I Processing High Performance Drives & IOPS

-
S
R ——
-
|
|

Archive
Storage Array

Lucene

—
I SAN

High Speed
?‘ @ Storage Array
Contact Upload Contact Playback Su p:rcvisor
—————r— —_——r—3
Webex WFO Storage Process Flow
Contact Upload Processing
-
[— = = = = = = = == == = =
Media File: Archival Storage @
I r_’ Archive
I g Storage Array
[ = = = = = = = = = = = = .I
L ] ﬁ Media File: Standard Storage I
N i i G R ) G e e
NAS, File Sterage, — e o o o
File Server ¥ -I
3) Store Contact into Mediz Storage *
P —
I &
I E @OE 2 SendtaAnaI\ft’lcsforPrucessing(lfConﬁgurEd]: Lucene
e I I T .
I ¢ High Speed Network Storage I Storage Array
ﬁ High Throughput Low Latency
| R |
- Supervisor
Agent PCl| eeessssssnsmsnens FC
Contact Upload e
L —
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Contact Playback Processing Diagram

[— = = = = = = = = = = =

I Media File: Archival Storage @
*8-24 Hr. Retrieval Rate I > Archive
Storage Array

o

| - Sl o ol o ol (el o o (o o ey

A A A

| ﬁ Media File: Standard Storage
& **Near Immediate Retrieval Rate I
D i e e i i
MAS, File Storage, P
File Server I 4 -I
I & 2] Retrieve Contact from Media Storage I
I LR e e e R e CEEEE R >
E 1) Lockup Contzct Details in I Lucene
I * Database I @ —
I © -
SAN
.................. @ Vo,
| HighSpeed Network Storage szj : | Storage Array
High Throughput Low Latency '
L o o o o oo o o o e o ot e o

pressssnnnnn

3) Playback Contact to Supervisor
Agent PC User L eeessas > PC

* If an offline storage option is used to store Media Files it can take an extended amount of time to

retrieve files for playback (8-24hrs). The system will alert the user when the file is downloaded and ready.

I NOTE For On-Premises deployments using an offline archival storage is non-typical.

** Retrieval and playback rates for Media Files stored on standard storage are available nearly

immediately depending on file size, quality, and network latency.

Webex WFO Storage Retention

The following diagram depicts contact retention processing.

34



System Requirements | About Storage

[™ = == == == o= o= oem o= e o= e .I
| Media File: Archival Storage ‘ﬁ I
Admin Configured: Storage profile and Retention Policy
I * See Storage Policy & Retention in Admin Guide I Archive
Y ¥ ¥ ¥ ¥ ¥ ¥ ¥F ¥ ¥ O¥® ¥ Storage Arrav
I I NN NN NN NN SN NN N NN SN AN 1
Admin Configured: Storage profile and Retention Policy
I Retention by 5torzge & Retention by contact type: I
. Contact Screen File Retention
I *  Contact Audic File Retention I
Al— " Contact State I
h I * Zee Storsge Policy & Retention in Admin Guide
MAS, File Storage, I I
File Server Media File: Standard Storage
I Admin Configured: Storage profile and Retention Palicy I
_-——— . . . o O e e S e e .
. G G ) G G R I E
I Files are stored temporarily on Network Storage and cleared —
I from Network Storage location after 24 hours I 2
I High Speed Network Storage (Temp) I—b @
24 Hr. Temp Storage “Self-Cleaning” Retention Policy I
| This is Not Configurable SAN Storage Array
-
Agent PC
- Supervisor
] i
Le———

*See the System Administrator User Guide for full details on storage policies and contact retention

policies.
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Port Usage

The port requirements for the Webex WFO components are listed below.

Generally, port 80 and port 443 to a web server need to be open to connect to Webex WFO for all cloud integrations with Webex WFO. Exact port requirements vary depending on your cloud

deployment model.

Edge Components:

= Smart Desktop

Data Server Components:

m Data Server—ACD Sync: Avaya CM with Contact Center Elite

m Data Server—ACD Sync: Avaya IP Office with ACCS

m Data Server—ACD Sync: CCaaS Integrations

m Data Server—ACD Sync: CUCM Network Recording

m  Data Server—ACD Sync: Cisco Unified Contact Center Enterprise (Unified CCE)

m Data Server—ACD Sync: Cisco Unified Contact Center Express (Unified CCX)

m Data Server—GIS

m Data Server—Record/Capture

m Data Server—Signaling: CTI

m Data Server—Signaling: CTI, Avaya Aura Communication Manager Recording

m Data Server—Signaling: CTI, Cisco Unified Communications Manager Network Recording
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m Data Server—Signaling: Genesys

m Data Server—Signaling: SIPREC

Edge Components

Port Use
Smart Desktop

UDP 49152—-65535 Live audio monitoring—RTP

Live screen monitoring—RDP stream

TCP 52102 Communication between Calabrio CTI data servers and SDC

Data Server Components

Port Use
Data Server—ACD Sync: CCaaS Integrations

TCP 443 Communication between CCaaS integrations and the following
settings on the Data Server: Regional Data Server ACD Capture
Settings, Recording CTI Signaling Server Settings, and Regional
Data Server ACD Capture Settings

Data Server—ACD Sync: CUCM Network Recording

Source

Agent’s PC

Smart Desktop

Source

Destination

Supervisor’s

browser

Data Server

Destination

Notes

Notes
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Port

TCP 22

TCP 8443

Data Server—ACD Sync: Cisco Unified CCE

TCP 1433
TCP 1434

TCP 1433
TCP 1434

TCP 42027

TCP 43027

Use

Communication between both the SFTP Configuration and the
Regional Data Server Reconciliation Settings on the Data Server
and the CUCM Billing Service

Communication between CUCM AXL and Regional Data Server
ACD Sync Settings on the Data Server

Communication between the Cisco Unified CCE AW SQL Server
Database and the Regional Data Server ACD Sync Settings on the

Data Server

Communication between the Cisco Unified CCE HDS SQL Server
Database and both the Regional Data Server Reconciliation Settings
and the Regional Data Server ACD Capture Settings on the Data

Server

Communication between the Cisco Unified CCE CTI Service (Side
A) and the Recording CTI Signaling Server Settings on the Data

Server

Communication between the Cisco Unified CCE CTI Service (Side

Source

CUCM Billing

Service

CUCM AXL

Cisco Unified
CCE AWDB
SQL Server
Database

Cisco Unified
CCE HDS SQL

Server Database

Cisco Unified
CCE CTI Service
(Side A)

Cisco Unified

Destination

SFTP, Data Server

Data Server

Data Server

Data Server

Data Server

Data Server

Notes

Side A default if using PG1. Ports
will vary based on what PG you are
using. The CTI Server Port configured
in the Unified CCE ACD

Configuration.

Side B default if using PG1. Ports
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Port Use Source Destination Notes
B) and the Recording CTI Signaling Server Settings on the Data CCE CTI Service will vary based on what PG you are
Server (Side B) using. The CTI Server Port configured
in the Unified CCE ACD
Configuration.

Data Server—ACD Sync: Cisco UCCX

TCP 1504 Communication between the UCCX Informix Database and both Data Server UCCX Informix  —
the Regional Data Server ACD Sync Settings and the Regional Database
Data Server ACD Capture Settings

TCP 12028 Communication between the Cisco UCCX CTI Service (Side A) and Cisco UCCX CTI Data Server Side A Default. This is the RMCM
the Recording CTI Signaling Server Settings on the Data Server Service (Side A) TCP port configured in UCCX

System Parameters. The CTI Server

Port configured in the UCCX ACD

Configuration.

TCP 12028 Communication between the Cisco UCCX CTI Service (Side B) and Cisco UCCX CTI Data Server Side B Default. This is the RMCM
the Recording CTI Signaling Server Settings on the Data Server Service (Side B) TCP port configured in UCCX

System Parameters. The CTI Server

Port configured in the UCCX ACD

Configuration.
Data Server—GIS

_ — — — While GIS does not directly listen on
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Port

Data Server—Record/Capture

UDP 3950043500

UPD 49152-65535

Data Server—Signaling: CTI
TCP 443

TCP 52102

TCP 52103

Data Server—Signaling: CTI, Cisco Unified Communications Manager Network Recording

TCP 2748

Use

Recording RTP

Live audio monitoring—RTP

Signaling Server

Recording Signaling

Hazelcast

JTAPI signaling

Source

Phone or voice

gateway

Record Server

Signaling Server

Record Servers or
Smart Desktop

clients

Signaling Server

partner

Signaling Server

Destination

Record Server

Supervisor’s

browser

Cisco API

Signaling Server

Signaling Server

Unified
CM publishers

Notes

a port, the files need to be copied
over to the Data Server. If the
copying is done via FTP, port 20 and

21 are used.
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Port

TCP 5060
UDP 5060

TCP 5061

Data Server—Signaling: SIPREC
TCP 443

TCP 5060
UDP 5060

TCP 59106

TCP 59107

Use

SIP signaling from Unified CM

Secure SIP signaling from Unified CM

Cisco API queries

SIP signaling from gateway

Recording signaling

Hazelcast

Source

Any Unified CM
publisher or

subscriber

Any Unified
CM publisher or

subscriber

Signaling Server

Gateway

Record Servers

Signaling Server

partner

Destination
and subscribers

Signaling Server

Signaling Server

Cisco API

Signaling Server

Signaling Server

Signaling Server

Notes

Not secure

Secure. Typically used only when
system is configured for SRTP.
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Data Transfer Flow Diagrams

This topic includes diagrams illustrating the following:

m Webex WFO Smart Desktop data flow

m Webex WFO recording capture and playback
m Webex WFO Analytics data flow

m Webex WFO storage data flow

m Webex WFO recording encryption

Smart Desktop Capture Data Flow Diagrams
This topic includes diagrams that describe the Smart Desktop data flow.

Smart Desktop SIP/SCCP Signaling

SIP Softphone
SIP or SCCP Hard Phone

(Optional)

Recording Services Two-stage Permanent
Upload Storage
L To RAW RTP
Recsive Cal Convert RAW| __|Convert WAV 128 Bit File EOPUS il encl;'p"l’:g e L1 Lp| Files at rest
! —————— to WAV * o oPUS » Encryption | ) fle e }I?TTPé 1 EOPUS
From .RAW
RTP
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Smart Desktop Live Audio Monitoring

SIP/SCCP Sofiphones
SIP or SCCP Hard Phone

Non-31P/H.323 via (RTP Logging Capture)

+» To .RAW RTFP

Receive Call

From RAW
RTP

Recording Services

Convert .RAW

to PCM Controller

—

Back-end Servers

Voice Data

Playback via HTTPS

&

Browser

9¢ ay
&

WFO
Server
Smart Desktop Live Screen Monitoring
All Recording Methods
Smart Desktop Client is required
Recording Services éﬁg‘i’::;‘; EoT e
Upload Storage
Screen Upload
Capt E t Fil i
a Osep ::]2 — WebM —» n‘fgyapBitl o EWebM ——t encrypted file |1 F'::SVZLR:St
per Screen via HTTPS

I NOTE Smart Desktop Live Screen Monitoring recording uses AES 128-bit encryption.

Recording Capture and Playback Data Flow Diagrams

This topic describes the process of playing back contact recordings.
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Audio Playback Data Flow Diagram

During playback, audio and screen recording files are copied from permanent storage and placed into a
secured cloud network storage, decrypted, and processed for playback .The files are simultaneously

decrypted and secured through network storage and HTTPS.

Permanent Storage
Files at Recording in encoding
rest directory for 24 hours
EOPUS (cached).
After 24 hours, file is
JI_ deleted.
¥
Copy File — EOPUS —»  Decrypt File — Opus — Pugmﬂ\::rb M —— WebM
> WAV
Back-end Servers

Used for speech

T

energy, speech :l
energy sent to o
browser ‘;

@

o

=

@

o

A
Browser
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Screen Playback Data Flow Diagram

Permanent Storage

F“riitat Recording in encoding
directory for 24 hours

EWebM (cached).
After 24 hours, file is

deleted.

Copy File > EWebM > Decrypt File > Webh

Back-end Servers

I

3

T

w

|

1+]

=]

=

1)

'f{.\'_

Y
Browser

Analytics Data Flow Diagrams

This topic describes the data flow for processing Analytics data.
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Phonetic Speech Analytics Data Flow Diagram

Permanent Storage
Files at
rest
EOPUS
I
3
4
: ' OPUS to WAV N
Capy File — ECPUS —» DecryptFile  |—® Opus — Conversion WAV file

- .
__.-= 4—— Store Results |#— Search Results [4— Aun(xplﬁ :Siz?mh <+ Aurix Indexing
Lucerne

Back-end Servers

After Aurix indexing,
OPUS and WAV files

are deleted
Speech Transcription Analytics Data Flow Diagram
Permanent Storage
Files at
rest
EQPUS
I
L
k4
) ; OPUS to WAV N
Caopy File ! EOFUS > Decrypt File — Opus — Conversion » WAV file
L
= -+ EJSON | Encryption — JSON <+ Transcription
Encrypted
Text Files
¢ After transcription,
OPUS and WAV files
. 3 are deleted
__‘-. <4+——— Search Results
[
Back-end Servers Lucerne

WFM Data Flow Diagram

This topic describes the data flow for precessing WFM real-time adherence and historical data.
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WFM Data Flow Diagram

GIS |
PR Real-time API Agent Real-time Adherence }7—p| WFM Real-time Adherence

Contact Center |
Applications [ WFM Historical Capture Workforce
> FISEoiceET (PSS Agent and Service Data =| Intervals (15/30) LETELETET

WHIT — WFM Historical Capture
Initial Bulk (6 Mo_+)
|

Storage Data Flow Diagrams
This topic describes the data flow for contact data storage in Webex WFO for CCaaS and customer-hosted

deployments.

This diagram illustrates the data flow for storage in on-premise implementations of Webex WFO in Avaya

environments:
Calabrio ONE
On-Premise Avaya Implementations
Calabrio Smart Calabrio
, Agent Workstation o SERE LSS pEy Elastic Grid
Avaya AES Recording (Screen Computing
Recording) Staging for Audio
Platform
& Screen
Recordings SSL
Applications
Web
Avaya Calabrio CTI Calabrio e S Database
Con;ﬂn;ﬁglc;tlon - Server - - Recoﬁll?dgi‘;ierver WEM Historical & Recording Storage
9 RTA Data Feeds
Avaya Gateway Recording
Avaya Elastic Grid
e ACME SBC Calabrio CTI astic Gri
Communication » L C i
SONUS SBC Server omputing
Manager Platform
SSL
Applications
Web
Calabrio CEETED
»| Recording Sarver Calaslznrse?ata Recording Storage
(Audio)
Avaya Soft Phone Recording
Avaya Avaya ONE-X Agent Calabrio Smart
Communication #| SIP/H.323 Signaling |-s—m Agent Workstation |-s—s- Desktop (Audio, Elastic Grid
Manager RTP to Soft Phone Screen, Analytics) Computing
Platform
Calabrio Data  [SSL_
Server Applications
Web
Avaya ONE-X Agent Calabrio Smart Database
#| SIP/H.323 Signaling |-s—m Agent Workstation |-s—- Desktop (Audio, Recording Storage
RTP to Soft Phone Screen, Analytics)
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Webex WFO Cloud Storage Data Flow Diagram
The diagram(s) below describes the different types of data storage types within Webex WFO. It presents

four pieces of information:

Data Transfer Flow Diagrams | Storage Data Flow Diagrams

m The names of the different types of storage

m  Where the data is stored

m How the data is accessed (either in real-time or delayed)

m  Whether the storage is within or outside of Webex WFO

ACD

Customer Domain

Analytics Speach
Processing
(Storage)

Media Playback
(Cached 24 Hours)

Archive Retrieval
(Cached 24 Hours)

C'opied to

-.— Media File Cache
Unencrypted for Playback

Media File
Cache

PBX

Calabrio Data
Server
{optional)
CTI Messaging

Agent Desklop

!

Calabrio Data
Server
(optional)
Audio Capture &
Staging Server

Media, Metadata, and

Analytics Data Upload

Calabrio Smart

Desktop Client

(Audio, Screen,
Desktop Analytics)

Calabrio Data
Server
(optional)
Staging Upload

o | Media, Metadata, and

7| Analytics Data Upload

Amazon Web Services

Calabrio ONE

High-performance Permanent Storage

(Media and Analytics)

Encrypted
Opus Audio Format
WebM Video Format

Non-configurable Storage Option

for Tenants

Calabrioc ONE

Standard Permanent Storage

(Media Files)

Encrypted
Opus Audio Format
WebM Video Format

Typically One-Two Year Retention

Calabrio ONE

Archival Permanent Storage

(Media and Analytics)

Delayed Response

Encrypted
Opus Audio Format
WebM Video Format

Playback Request
User Notified When Available

Typically Long-term Retention
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Cloud Storage for CCaaS deployments

Customer Site

ACD

21 -

User workstation with
audio capture

Smart

Amazon Web Services

Desktop

Media, metadata, and
Analytics data upload

Calabrio ONE Clou

Copied to
— Media File Cache
Data Type Unencrypted for Playback
Analytics Speech Processing (Storage)
Media Playback (Cached 24 Hours) Media File )
Cache Copied to
. . 4— MedaFile Cache
Archive Retrieval (Cached 24 Hours)
Unencrypted for Playback
&,
", %"«vf%

Calabrio ONE
High speed network storage

Encrypted
Opus Audio Format
WebM Video Format

for Tenants

Non-configurable Storage Option

Calabrio ONE
Media file standard storage

Encrypted
Opus Audio Format
WebM Video Format

Typically One-Two Year Retenti

L

Delayed Response

Additional Calabrio
ONE Cloud
Applications

&

Playback Request Encrypted
User Notified When Available Opus Audio Format
WebM Video Format

Calabrio ONE

Media file archival storage for delayed

access

—

Elastic Grid
Computing Platform

Web
Database

Applications

Recording Storage
Glacier Storage

Typically Long-term Retention

[

_ _Npigpowered by
frrramazon
ii webservices

50



Cloud Storage for Customer-hosted ACD deployments

Customer Site

E
ACD E
PBX

User Workstation

Calabrio ONE
Data Server

CTI Service

Signaling
Service

A,
Audio

Desktop

Capture
Service

Staged Upload
Service

Analytics Speech Processing (Storage)

Data Type

Media Playback (Cached 24 Hours)

Archive Retrieval (Cached 24 Hours)

Media File
Cache

Unencrypted for Playback

Media, metadata, and
Analytics data upload

ONE Cloud
Applications

Applications
Web
Database

Calabrio ONE Cloud

Additional Calabrio

Recording Storage
Glacier Storage

Copiedto
l—  MediaFile Cache

Unencrypted for Playback

Copiedto
l— MediaFie Cache

Delayed Response
Playback Request
User Notified When Available

Amazon Web Services

Calabrio ONE
High speed network storage

Encrypted
Opus Audio Format
WebM Video Format

Non-configurable Storage Option
for Tenants

Calabrio ONE
Media file standard storage

Encrypted
Opus Audio Format
WebM Video Format

Typically One-Two Year Retention

Calabrio ONE
Media file archival storage for delayed|
access

Encrypted
Opus Audio Format
WebM Video Format

&=

Typically Long-term Retention

powered by
amazon
webservices

SAML Authentication Process Flow Diagram
This topic describes the process for SAML authentication.

All authorization and authentication of known user identities is managed by the customer within the

Identity Provider (Authorization Server) and outside of Webex WFO Cloud. Webex WFO acts as the

service provider (resource server) and consumes all user identities from the customer’s identity provider

(IdP). Known user identities that are active within the customer’s IdP are provided proper authorization to

access https://calabriocloud.com through a SAML authorization communication between the

customer’s IdP and Webex WFQO’s Resource Server.

Data Transfer Flow Diagrams | SAML Authentication Process Flow Diagram
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SAML Approval process
Authenticated Calabrio ONE Cloud
Session \:.'eh Services
https:/icalabriocloud. com
— NI @
SAML 2.0
Authori zation
Request
A
Q@
Customer Domain
L i 1dP Authorization
Agent - & (ADFS, Dtka, Ping
Workstation =t b
E .
4 4
Calabric ONE Calabric ONE
(EBS/S3) RDS Services
Data Storage
Tenant Secured Tenant Secured

Data Database
- -
= -

Steps for SAML authentication:

1. The user accesses https://calabriocloud. com; if the user has an authenticated session with the

IdP (Authorization Server), the user is allowed access.

2. If the user does not have an authenticated session, create a SAML Authentication Request and

redirect back to browser to the IdP (Authorization Server).

3. If the user is not already authenticated with the IdP (Authorization Server), the user is asked to log
in.

4. After the user successfully logs into the IdP, or if they were already logged in, the IdP sends a

redirect back to the browser with a SAML response.

5. Webex WFO validates the SAML response, receives the user’s information from the SAML

response, creates an authenticated session, and allows access.
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SAML Denial Process

—X 0o

Authenticated \ Calabrio ONE Cloud

Session Web Services
K
https:/icalabriocioud com

Y A @
SAML 2.0
Authorization
Request

Calabrio ONE
Application Grid Server

@
N -
/\
Customer Domain
y @® IdP Authorization
Agent ~ X AEE
Workstation { 2, Uitka, Fing
identity)
E:‘ V4
VAN
Calabria ONE Calabrio ONE
(EBS/S3) RDS Services
Data Storage
ADP Secured ADP Secured
Data Database
- -
- -

Steps for SAML authentication denial:

1. The user’s authentication access has been terminated in the IdP.

2. Ifthe user does not have an authenticated session, create a SAML Authentication Request and

redirect back to browser to the IdP (Authorization Server).

3. Because the user is not authenticated with the IdP (Authorization Server), the user is asked to log
in.

4. The user is unable to authenticate with the IdP (Authentication Server), and is not authorized.

5. The user is denied access.

Recording Encryption
The following diagram describes the encryption of recordings in Webex WFO.
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Customer Domain

Calabrio ONE Data Storage

Secured HTTPS Transfer

Encrypted Client Storag Encrypted Permanent Storage

All data is encrypted and transported via secured HTTPS/SSL from customer premise to Webex WFO for

processing and storage.

In Cloud deployments, the available encryption method is RSA-2048 (with asymmetric keys) and AES-
128.

In cloud deployment of Webex WFO, only the tenant (not Webex WFO Cloud Operations) controls the
keys used to encrypt recordings, and these keys are stored in the tenant’s database. In addition, a second
layer of encryption is embedded into Webex WFO, which Webex WFO Cloud Operations also does not

have access to.
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